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Microsoft Power Point 2007 
 Power Point full featured presentation graphics application capable of creating 

dynamic slide shows. slide shows can contain audio, video, graphics, and be fully 
iterative. the screens can be projected, printed, converted into overheads, or published 
on the web. presentations can be delivered by a speaker, displayed in a elf running 
kiosk, or published as web pages with treaded discussions. 

 
Starting Power Point  

• Start All ProgramsMicrosoft Power Point 

• Desktop  icon  
• My computer C: Program files   Microsoft Office  office 10  Microsoft 

Power Point 
ppt)*.the extension of files created  in power point are (     
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  Office Button  
New: creating a new, blank presentation takes only a click. Click the New button   
on the office button or click the Blank Presentation link on the new Presentation task 
pane. 
 

  Open: you have met with Victoria and discussed some changes that need to be made 
to repurpose the existing presentation. You will begin your review of Victoria's 
excising presentation by opening it in power point. 
Opening a Presentation 

• Select office button , Open, or click the open button  , the open dialog 
box appears. 

• If the file isn’t in the currently displayed folder, select the Look In drop – 
down arrow to choose from a list of other drives and / or folders. 

• Browse to the location containing the file and double – lick it to open it in 
Power Point. 

 

 
 
Save: after you create a new presentation, it makes sense to save it. To save a 
presentation. 
Saving a Presentation 

• Select office button , Save, or just click the save button  on the title 
bar. The save as dialog box appears. 

• In the File Name text box, type the name you want to assign to the 
presentation. 

• The save in box sows in which folder the file will be saved. Click the Save In 
drop-down arrow and select one from the list that appears. 

• Click Save.  
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Print: using the Print option of the File menu pens the Print dialog box ,which allow 
custom printing selection. 
Printing a Slide Show 

• From the office button  select print. 
• In slides sized for box, click the desired option usually letter paper 

(8.5x11in).click OK. 
• Click the Print Preview  button from the sub menu 
• Use Options to add Header and Footer. 
• Use Options to change the Colors/Grayscale. 
• Use Options to select Scale to fit Paper. 
• Click the Print  button. 

 
 

Print Preview: Power Point's Print Preview screen provides options for selecting 
what to print (slides, notes, handouts, or outline). 
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Send To: the send to option of the file menu is an easy way to export data from your 
current application to another office application. 
Using Send To 

• Open the document that you would like to send to an e-mail address or another 
application. 

• Click Send to option of the office button . 
• When sending from Power Point to Word, select what to send from the send to 

Microsoft word dialog box. 
• When sending to an e-mail, you will need to select or enter a valid e – mail 

address. 
 
Close: you can close a presentation at any time. note that although this closes the 
presentation window, it does not exit Power Point. 
Closing a Presentation 

• Select office button , Close, or click the presentation Close (x) button. if 
you haven’t saved the presentation or if you haven't saved since you last made 
changes, a dialog box appears, asking whether you want to save. 

• To save your changes, click yes. 
 
Undo: the undo button of the standard toolbar can be used to correct many mistakes 
made while editing.  
 

  The redo button will repeat an undone action.: Redo 
 

Home Commands 

 
Clipboard: include: 

 Cutting, Coping, and Pasting Slides 
• Changing to Slide Sorter view, or display normal view and work with the 

outline or slides panes. 
• Select the slides you wan to copy or cut. 
• Open the home,clipboard menu and select Cut  or Copy  to either move 

or copy the slides, respectively, or you can use the Cut or Copy toolbars 
buttons.(from the key board press Ctrl+C to copy or Ctrl+X to cut). 

• In Slide Sorter view, select the slide after which you want to place the cut or 
copied slides, or on the outline pane, move the insertion point to the end of the 
text in the slide after which you want to insert the cut or copied slides. 

• Select the home, clipboard menu and choose Paste, or click the Paste  
toolbar button. Power Point inserts the cut or copied slides.(from key board 
press Ctrl+V to paste an item that you cut or copied). 
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Format Painter: copy formatting from one place and apply it to another. 
Double – click this button to apply the same formatting to multiple places in document. 
 
Slides: include: 
  New Slide: it is used to insert a slide into a presentation at any time and at any 
position in the presentation. 

 
Inserting a New Blank Slide 

• On the outline or slides pane, select the slide that appears just before the place 
where you want to insert the new slide ( or In the slide sorter view). 

• Choose the home, slides and then New Slide, or click the new slide button 
 on the power point toolbar. A new blank slide appears in the power 

point window. Along with the slide layout task pane. 
• In the slide layout task pane, select the slide layout that you want to use for the 

new slide. 
• Follow the directions indicated on the slide in the slid pane to add text or other 

objects. 
 

Duplicate: New slide contains a duplicate option that can be used to copy objects. 
This selection can be accessed with the shortcut keys Ctrl+D.  
 
Slide from outline: if you have created a document in Word that includes outline 
style headings and numbered or bulleted lists, Power Point can pull the headings and 
the text from the document and create slides. 
Creating Slides from a Document Outline 

• Choose the home, slides, new slides menu, and then choose Slides from 
Outline. The insert outline dialog box appears. 

• Use the Insert Outline dialog box to locate the document file you want to use. 
• Double – click the name of the document file. 

 
Slide Layout: the slide layout sets the format of the text and graphic content of a slid. 
When a blank presentation is opened or a new page added to an existing presentation, 
the slide layout task pane displays .the slide layout task pane shows standard 
presentation page layouts containing various combinations of text and graphics. 
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Reset: reset the position, size, and formatting of the slide placeholders to default setting. 
 
Delete: you can delete slide from any view. 
Deleting Slides 

• Select the slide you want to delete. You can delete multiple slides by selecting 
more than one slid. 

• Choose the Home, Slides, and then choose Delete Slide. The slide is removed 
from the presentation. (Or press Delete key on the keyboard).  

 
Font: include: 
Font :The font dialog box offers you control over all the attributes you can apply to 
text. Attributes such as strikethrough, superscript, subscript, and shadow are available 
as check boxes in the dialog box. 
Using the font dialog box 

• To change the font of existing text, select text by clicking and dragging the I-
beam pointer over the text in a particular text box. 

• Choose the Home and then Choose Font. The font dialog box appears. 
• From the Font List, select the font you want to use. 
• From the Font style list, select any style you want to apply to the text, such as 

Bold or Italic 
• From the Size list, select any size in the list, or type a size directly into the box. 
• In the Effects box, select any special effects wants to add to the text, such as 

Underline, Shadow, or Emboss. You can also choose Superscript, Subscript. 
• To change the color of the text, click the arrow button to the right of the color 

list ad click the desired color. 
• Click OK to apply the new look to the selected text. 
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Paragraph: include: 
Bullets and numbering: it is used to add bullets to selected paragraph on the slide.  
Making a Bulled List  

• Click the paragraph that you want to format for bullets. 
• Select the Home, paragraph menu, and then select Bullets and Numbering. 

The dialog box appears. 
• Select the bullet style you want to use from the list Power Point provides. 
• Click OK. Power Point formats the selected text into bulleted list. 

 
Alignment: it is used to change paragraph alignment: 
Changing text alignment 

• Click anywhere inside the paragraph wants to realign. 
• Select the Home, paragraph menu and then select Alignment. 
• Select Aligns left , Center , Align right , or Justify  to align the 

paragraph as required. 
 

Drawing: include: 
Shape: it is use to insert an Auto shape onto a slide. 
Adding shape  

• In the slide view, display the slide on which you want to place the picture. 
• Click the home, point at Drawing, and then select auto shapes, the dialog box 

appear. 
• Click he sample that best represents the object type you want 
• click ok, Power Point create the Picture on your slide.  

 
Editing: include: 
Find And Replace: Power Point's Find and Replace commands allow representation 
to be searched for specific characters. 



9 
 

Find Text 
• Click the home, editing menu and then click Find. 
• Enter the search string and select the appropriate options. 
• Click the Replace button to specify a replacement value. 
• Do one of the following. 
• Click Find to locate the next occurrence of the find what string. 
• Click Replace to update the current occurrence of the find what string with the  
Replacement value. 
• Click Replace All to replace all instances of the find what string with the 

replace with string. 
 

Select All: it is used to select all slides. (In slide sorter view). 
Insert Commands 

 
 
Table: it is used to insert a table onto an existing slide.  
Creating a Table 

• Display the slide on which you want to place the table. 
• Select the Insert menu and then choose Table. The insert tale dialog box 

appears. 
• Enter the number of rows and columns that you want to have in the table. 
• Click ok. He table appears on the slide. 

 
 
Illustrations: it is use to insert a picture or clipart or photo album or shapes or smart 
art or chart onto a slide. 
Adding illustrations  

• In the slide view, display the slide on which you want to place the picture. 
• Click the Insert menu, point at illustrations, and then select (clipart, or 

picture, or photo album or smart art shapes, or chart), the dialog box appear. 
• Click the sample that best represents the object type you want 
• Click ok, Power Point create the illustration on your slide.  
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 Charts are used to represent numeric data graphically. Charts 
Create a Microsoft Graph 

• Select the most appropriate content layout for the slide that will contain the 
chart. 

• Click the chart  icon in the content placeholder to activate Microsoft graph. 
• Enter the data to be charted in the datasheet with headings in the first row and 

column, and data in cells that can be referenced with a letter and number 
• Use the chart menu to select chart type, subtype, and option. 
• Right click on any chart object to format it. 
• Click the slide background to exit Microsoft graph. 

 
 

 
 

Links: include: 
Hyperlink: create a link to a web page, a picture, e-mail address, or a program. 
 
Action: are ready made buttons that can be placed on a slide to intuitively control 
slide progressions. Once a button is placed on slide, it is assigned a hyperlink that 
controls its action. 
Create and link an Action Button 

• Select the slide to contain the Action Button. 
• Click the Auto shapes button of the drawing toolbar, pause over Action, and 

select he desired button. 
• Click and drag the button on the slide surface. 
• Click the action button and follow the steps to set a hyperlink. 

 
 Text: include: 
Textbox: insert the text box to document, or insert text box to selected shape. 
 

Header and Footer: a header is any text that prints in the top margin of pages, and 
footer is ay content that prints in the bottom margin. Slide headers and footers can be 
added and updated using the header and footer option of the view menu in either the 
normal or slide sorter view. They can also access from print preview. 
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Word art: insert decorative text in your document. 
 

 
 
Slide number: to insert numbers to the slides. 

 
  To insert date and time to the slides.  :Date and time 

 
Symbols: to insert symbols to the slides. 
 
Object: insert an embedded object. 
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Media clips: include: 
Move and Sound: a great way to add some interest to the Power Pint Presentations is 
to add sounds and movies to slides. Sounds enables to emphasize certain slides, and 
movie animations an add humor and style to presentations. 
 
Placing a Movie onto a Slide 

• Choose the Insert menu, point at Media clips, and then select Movie . 
• Scroll through the movies listed on the Clip Art task pane. 
• Point at a movie clip you want to preview. Click the menu arrow that appears 

and select Preview/Properties. The Preview/Properties dialog box for the 
movie appears. 

• PowerPoint previews the movie on the left side of the dialog box. 
• Click Close to close the Preview/Properties dialog box. To insert the movie 

into your slide, click the movie in the task pane. 
• A dialog box will open allowing you to choose how the movie will be started 

during the slide show. Click automatically or when clicked. 

 
 

Inserting a Sound onto a Slide 
• Select the slide on which you will place the sound, so that it appears in the 

slide pane. 
• Select Insert, point at Media clips, and then select Sound. 
• To preview a particular sound file, point at the file and click the menu arrow 

that appears. Select Preview / Properties from the menu. The Preview / 
Properties dialog box for that sound file appears. 

• The sound will play automatically when the Preview / Properties dialog box 
opens. You can click the stop, Pause, or Play buttons to perform that particular 
function. When you have finished previewing a sound file, click close to close 
the Preview / Properties dialog box. 

• When you are ready to insert a sound file onto the slide, click the sound file on 
the task pane. 

• A dialog box opens, asking you whether you want the sound to play 
automatically when you run slide show. Click ye to have the sound played 
automatically. Click no to setup the sound so that you will have to lick it 
during the slide show to play the sound. 
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Design Commands 

 
Page setup: include: 
Page Setup: the page setup dialog box enables you to select how slides, notes, and 
handouts should be oriented o the page(portrait or landscape) and the type of page 
that the slides should be formatted for, such as on screen show, overhead sheets, or 
regular paper. 
Changing the Page Setup 

• Select the design menu and select Page Setup. The page setup dialog box 
appears. 

• Set the slide size. 
• In the Number Slides Form text box, type the number with which you want to 

start numbering slides. 
• Under the slides heading, choose Portrait or Landscape orientation for your 

slides. 
• In the notes, handouts & Outline section choose Portrait or Landscape for 

those items. 
• Click OK. 

 

 
 
Slide orientation: switch the slide orientation between portrait and landscape. 
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Themes: include: 
Themes: you can apply a different template to your presentation at any time, no 
mater how you originally crated presentation. 
Apply different Design  

• Select Design, themes. 
• Click the template that you want to use in the list. the template is immediately 

applied to the slide in the slide pane. 
• When you have decided on a particular template, save the presentation.  

 
Colors: change the colors of current themes. 

 
Fonts: change the fonts of current themes. 
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Effects: change the effects of current themes. 

 
 
Background: 
Background: changing the color of a slide background can be accomplished by 
adjusting the background component of the color scheme, or using the background 
color menu. The back ground color menu can also be used to change the slide 
background to a texture, fill pattern, or picture. 
Define a Gradient Background 

•  Click on  
• Click the format Background popup menu option. 
• Click Full Effects 
• Click the Gradient tab or Texture or Picture 
• Select the desired gradient effects and click OK. 
• Click either 
• Apply to All to set this as the background for all presentation slides. 
• Apply to set this as the background for the selected slides only. 
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Animations Commands 

 
Preview: preview the animations and slide transition you have created for this slide. 
 
Animations: choose an animation to apply it to objects inside the slide. 
Custom animation: any object on a Power Point slide can have motion added to it 
using Custom Animation setting from the custom Animation Panel of the task pane. 
Using custom animation, each character of text on a slide can be controlled 
indecently, grouped by word, or animated by paragraph. 
In addition to animating text, Power Point has the ability to animate graphics, charts 
and drawn objects. 
The start options of an animation are set to control when it begins to play. other 
animations options are available from the timing tab of effect option selection these 
option will allow more complete control of start times, delay between animation, the 
speed of the action, the duration of an animation, how each animation is repeated, and 
the trigger that initiates the animation. 
Adding Custom Animation to text 

• In normal view, select the text object to be animated. 
• From the Animations select Custom Animation. 
• In the custom animation task pane click Add effect and select the desired 

effects. 
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Transition to this slide: control the visual effect that displays between slides in a 
slide show. The available transitions range from mild to dynamic in their impact. all 
slides can use the same transition, or different transitions can be assigned to each 
slide. 
Apply Transition to this slide 

• Select the slides the transition will be applied to. 
• From the animations menu select Transition to this slide. 
• Select a transition effect. 

 
Transition sound: select a sound to play during the transition between the privies 
slide and current slid. 
Transition speed: choose how fast to animate between the privies slide and current 
slid. 
Apply to all: set the transition between all slides in the presentation to be like the 
transition you have set up for the current slide. 
On mouse click: wait until a mouse click to move to the next slide. 
Automatically after: move the next slide after a certain numbers of seconds. 
 

Slide Show Commands 

 
 
Start slide show: include: 
From beginning: start the slide show from the first slide. 
From current slid: start the slide show from the current slide. 
Custom slide show: displays only slides you are select. 
 
Setup: include: 
Set up slide show: set up advance options for slide show . 
 
Hide Slide: sometimes a single presentation can be customized to meet the needs of 
multiple audiences or presentation form. 
Hide a slide 

• Select the slide to hide on the slides tab in normal view. 
• On the Slide Show, set up then click Hide Slide. 

 
Rehearse Timing: to set time for each slide. 
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Set Slide Trimming While Rehearsing 
• Active the timing feature 
• On the Slide Show menu, click Setup Show 
• Under Advance Slide, click Use Timing, if Present 
• Set the time for each slide 
• On the Slide Show menu, click Rehearse Timing 
• Rehears the show to set trimming automatically as you advance. 
• At the end o the show, click yes to accept automatic timing or no to start again. 

 

 
 

Monitories: include: 
Resolution: choose the screen resolution to use for the full screen slide show. 
Use presenter view: show the full screen slide show using presenter view. 
 

Review Commands 

 
Spelling: as you enter text, it is checked against the dictionary. When a word I not 
found in Power Point's dictionary, it is marked with a red wavy underline for your 
review. 
Correct Words Marked by Spelling Checker 

• Edit a word with a red wavy underline to correct the spelling manually. 
Or 
• Right click on a word with a red wavy underline for suggestions and then do 

one of the following: 
• Select the correct spelling from the list of suggestion. 
• Select ignore all to ignore this word in the current presentation. 
• Select add to dictionary to add this word to the dictionary for all presentations. 
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View Commands 

 
Presentation view: include: 
Normal  : when creating and editing a presentation, normal view will be used to 
move between slides and from object to object within slide. The normal view 
containing the outline pane, slide pane, notes pane, and task pane. The outline pane 
contains two tabs, the outline tab and the slides tab. the outline tab displays an 
outline of the current presentation consisting of the titles and text from each slide. 
The slides tab displays the slides of the slide show a thumbnail sized images. 

 
 
 
 
 
 
 
 

 
Slide Sorter  : slide sorter view shows thumbnails of the slides in presentation slide 
sorter view provides the ideal environment for arranging slides in the appropriate 
order for your presentation. 

 
 Slide Show  :  Before you show your presentation to an audience ,you should run 
through it several times on your own computer , checking that all slides are in the 
right order and hat the timings and transitions between the slides work correctly.  

 
 Note Page : this view provides a large pane for creating note for your speech. you can 
also type these notes in normal view, but notes page view gives you more room and 
allows you to concentrate on your note text.  
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 Slide Master: a side that contains the master layout and color scheme for the slides in 
a presentation. 
Hand out master: open handout master view to change the design and layout of printed 
handout. 
Note master: open notes master view. 

 
Show /hide: include: 
Rulers: view the rulers, used to measure and line up objects in the document. 
Grid: when grids are turn on ,dotted lines display at regular intervals on each slide 
.when guides are activated, one horizontal and one vertical line are added to the slide 
to be positioned as needed to align slide objects.   
View direction: from left to right or from right to left. 

 
Zoom: include:  

 Zoom: the zoom command uses to zoom in and out on the presentation. 

 
Fit to window: zoom the presentation so that the slides fill the windows. 

 
Color/gray scale: include 
Color: view this presentation in full colors. 
Gray scale: view this presentation in gray scale. 
Pure black &white: view this presentation in black &white. 

 
Window: include 
New window: open a new window containing the view of current document. 
Arrange all: tile all open program window side by side on the screen. 
Cascade: cascade the open document windows in the screen so that they overlap. 
Move split: move the splitters which separate the different sections of the window. 
Micros: view the list of macros, from which you can run, create, or delete a macro. 

Acrobat Commands 

 
Create adobe PDF: Create adobe PDF from current document. 
Create and Email: Create adobe PDF and attach to new email. 
Review and Comment: Create adobe PDF and imitate a shared review. 
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Examples  
Create slide show contained seven slides as follows: 

1. First slide is the title slide, with major title using word art " Computers" and 
manor title "Computers Application" . 

  
2. Second slide is bullets text  with major title using word art "Computer 

Hardware" and following text: 
• Input / output units 
• Control unit 
• Memory unit 
• Storage unit 
 
3. third slide , contains two columns with major title using word art "Computer 

Software" ,in first column enter the following data: 
• Ms dos 
• Windows 
• Internet 

     In second column enter the following data: 
• Word 
• Excel 
• Power point 

 
4. fourth slide ,contain table with title "Microsoft office" 

Office3 Office2 Office1  
25 30 20 Word 
20 30 10 Excel 
35 25 30 Power point 

 
5. Fifth slide is draw slide contains graphic charts for previous data. 
6. Six slide, insert computer picture from clip art. 

 
7. Seven slide, contain the table and the chart and the picture. 
8. Add appropriate background to all of the slides. 
9. Add different effects to slides, and objects onto slides. 
10. Save the file, and show the presentation using two ways :by mouse click and 

by determine time for each slide display. 
   

 اتمنى ان لا ينتج الاصدار اللاحق قبل الانتهاء من كتابة هذه المحاضرات.
 


